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Safety Instructions

Your MC101 is designed and tested to meet the latest standards of safety for information technology equipment.

However, to ensure your safety, it is important that you read the following safety instructions.

Setting up your system

-+
X

>

7

_

~—

‘:E__"-—h.k_‘___‘_‘:}-_' = i.”‘.
Ay

-

N
i1 l i; | ‘
| .

1. Do not use this product 2. Do not block the air vents 3. Do not use or expose this
near water or a heat to this product or impede product around magnetic
source such as a radiator. the airflow in anyway. fields as magnetic

interference may affect the
performance of the
product.

Care during use

1. Do not spill water or any other liquids on your system.
2. When the system is turned off, a small amount of electrical current still flows. Always unplug all power, modem, and
network cables from the power outlets before cleaning the system.
3. If you encounter the following technical problems with the product, unplug the power cord:
. The power cord or plug is damaged.
. Liquid has been spilled into the system.
. The system does not function properly even if you follow the operating instructions.
. The system was dropped or the chassis is damaged.

. The system performance changes.

Warranty

This ARCTIC product includes a 2-year limited warranty. For further information, please consult warranty.arctic.ac
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m Introducing the MC101

1.1 Packaging Contents

g

MC101x 1 TV Antenna x 1 AC Power Cablex 1

xSt
Ouéuide

AC Power Adapter x 1 HDMI Cable x 1 Quick Start Guide x 1

1.2 Front, Side and Rear View
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m Introducing the MC101

eN  Front & Rear View

. Power Button

. TV Antenna

. Audio Output Jack

. Line in Jack

. Optical Out (SPDIF)

USB 2.0 Port x 4
DC Power Jack
USB 3.0 Port x 2
HDMI Port

0. Ethernet Port

11. 4 in 1 Memory Card Reader (SD, MMC, MS, XD)
12. Combo eSATAp + USB 2.0 Port

13. USB 3.0 Port

14. Headset / Audio Output Jack
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m Connecting the MC

101

2.1 Connecting USB 3.0/ 2.0 Devices

USB 3.0
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*USB 3.0 devices will not achieve full speed if plugged in the rear panel USB 2.0 ports.

2.2 Connecting the Video Display

2.3 Connecting the Network

Wireless Connection
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Ethernet port

Wireless
Network

Fax /Scanner  HDD Enclosure Smartphon USB Hub Keyboard
N 2 &
WU o=k
| & .
) o &
Mouse UusB Webcam Gamepad ~ Bluetooth
flash drive USB Dongle
(O r——a( )]
-
HDMI Cable Projector Amplifier LCD/LED
Monitor

Cable / DSL
Modem

Wireless
Router

Internet
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Wired Network Router

Cable / DSL
Modem
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Internet



m Connecting the MC101

2.4 Connecting the Speakers

Analog connection - 2.0 and 2.1 systems
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2.1 System Audio olgtpm HDMI port TV / Monitor
|ac
Digital connection (Optical) - 5.1 and 7.1 systems
= = ——
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HDMI
5.1/7.1 Optical Out port ;
System (SPDIF) TV / Monitor
Amplifier connection (HDMI)
n =28 = - e —
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- HDMI cable HDMI cable
= ==
HDMI port Amplifier TV / Monitor

Note : your amplifier need to be HDMI pass-through

2.5 Connecting the Power Cord
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DC power jack

Power cable




3.1 Enable Full Screen

In some case, when you connect the video display through HDMI cable, the displayed image does not fill up the full

screen. This can be adjusted with the following steps:

1. Right click on the desktop and select “AMD VISION Engine Control Center” or select it from “Start Menu”.

AV e Contrl e

e
Swt by
nenen

Fame moncie
[ —

Change your display settings and enabls additional displays.

Add/Remove Displays
Desktop Management
My Digitsl Flat-Panels
Advanced Display Setiings

Power
Change power setfings to maximize battery life or reduce power usage.

PowerPlay™

Video
Enhance the quality of video playback or convert videos to ather file formats.

Video Color
Video Quality

Gaming

Manage graphics settings for gaming.
Gaming Performance
Image Quality

Information
Learn more about your computer hardware and software.

e %2 U =

Product Summary
AMD Home




Using the MC101

3. Select “My Digital Flat-Panels”.

VISION AMD VISION Engine Co

AMDD Preferences

Start  Desktops and Displays

> Pinned

£
» Presets & w Desktops and Displays

'y Add/Remove Displays
Manages topology of displays and desktops in the system by enabling and dissbling them.

Detect Displays

Desktop Management

Manage how Windows desktops appear on my displays
Deskiop Properties
Rolate Deskiop
Deskiop Color

or DVI).
Properties (Digital Flat-Panel)
Display Color (Digital Flat-Panel)
Scaling Oplions (Digital Flat-Panel)

My Digital Flat-Panels
‘Contrel how images appear on digitel flat-panel displays (connected by HDMI™, DisplayPort™,
Mare.

HydraVision™
Mansge window placement scross muliiple displays using HydraGrid, Multi Deskiop, and
Desktop Manager.

| HydraGrid
Deskiop Manager
3 Multi Deskiop

Maximize

VISION AMD VISION Engine Co|

AMDI Preferences

Desktops and Displays My Digital Flat-Panels

> Pinned &

— @ My Digital Flat-Panels

Properties (Digital Flat-Panel)

I View and configure display properiies (such as supported resolution and refresh rate), scale images, and
enable video quality processing for HOMI™ displays.

Properties (Digital Flat-Panel)

Display Color (Digital Flat-Panel)

Configure color setfings, such as brightness and contrast, for an individual display.

Display Color (Digital Flat-Panel)

Scaling Options (Digital Flat-Panel)
Adjust the edges of your display ares to better fit your digital flat-panel.

Scaling Options (Digital Flat-Panel)

HDTV Support (Digital Flat-Panel)

Create custom HOTV resclutions to better fit the display area to your digital flat-panel.

HOTV Support (Digital Flat-Panel)

LCD Overdrive (Digital Flat-Panel)

Improves the quality of fast-moving objects during video playback on certain LCD panels

LCD Overdrive (Digital Flat-Panel)




Using the MC101

5. Tick “Enable GPU scaling” and select “Apply”.

VISION AMD VISION Engine Co|

AMDR Preferences

Start = Desktopsand Displays My Digital Flat-Panels  Properties (Digital Flat-Panel)

> Pinned ¥ Properties (Digital Flat-Panel) - 7

> Presets @

View and configure display properties (such as supparted resolution and refresh rate), scale images, and
enable videa quality processing for HDMI™ displays.

Panel Information

Display Mame: VX2433wm
Maximum reported resclution: 1920x1080
Mazximum reported refresh rate: 75 Hz

Image Scaling
Enable GPU scaling

Maintain aspect ratio
@ Scale image to full panel size
Use centered timings

Enable ITC processing

e

6. If the PC does not change to full screen after enabled the GPU scaling. Go to the tap above labelled “My digital

Flat-Panels”.

VISION AMD VISION Engine Control Center

AMDD Preferences

) Start " Deskiops and Displeys | JUMIDRAIGREPSREENY |Propertes (Digial Fla Pa

> Pinned ¥ Properties (Digital Flat-Panel) - 7

> Presets ”

Wiew and configure display properties (such as supported resolution and refresh rate), scale images, and
enable video quality processing for HDMI™ displays.

Panel Information

Display Name: VX2433wm
| Maximum reported resolution: 1920x1080
Maximum reported refresh rate: 75Hz

Image Scaling
Enable GPU scaling

Maintain aspect ratio
@) Scale image to full panel size
Use centered timings

Enable ITC processin
P 9
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7. Go to the “Scaling Options (Digital Flat-Panel)”

VISION AMD VISION Engine Col

AMOD Preferences

Start Desktops and Displays

> Pinned '3 | .
— ” My Digital Flat-Panels

Properties (Digital Flat-Panel)

’ iew and configure display properties (such as supported resolution and refresh rate), scale images, and

enable video quality processing for HDMI™ displays

Properties (Digital Flat-Panel)

Display Color (Digital Flat-Panel)

Configure color seftings, such as brightness and contrast, for an individual display.

Display Color (Digital Flat-Panel)

Scaling Options (Digital Flat-Panel)
Adjust the edges of your display area to better fit your digital flat-panel.

Scaling Options (Digital Flat-Panel)

HDTV Support (Digital Flat-Panel)

Create custom HDTV resolutions to better fit the display area to your digital flat-panel

HDTV Support (Digital Flat-Panel)

LCD Overdrive (Digital Flat-Panel)

Improves the quality of fast-moving objects during video playback on certain LCD panels

LCD Overdrive (Digital Flat-Panel)

8. Under the scan option, adjust the scale from15% to 0% until full screen is achieved.

VISION AMD VISION Engine Control Center

AMDR Preferences
=) Start ~ DesktopsandDisplays ~ MyDigital Flat-Panels  Scaling Options {Digital Flat-Panel)
> Pinned # Scaling Options (Digital Flat-Panel) - 7
| » Presets ﬁ Adjust the edges of your display area to better fit your digital flat-panel.

| Scaling Options

Underscan U COverscan
10% Ui
| Use the scaling values instead of the customized
| settings when the desktop resolution does not match

your DFP resolution,

== o

—




9. Click “Apply” to activate the full screen or “Discard” to go back to the last screen size

VISION AMD VISION Engine Control Center

Preferences

» Start  DesktopsandDisplays My Digital Flat-Panels  Scaling Optians (Digital Flat-Panel)
> Pinned ¥ Scaling Options (Digital Flat-Panel) - 9

> Presets ’l Adjust the edges of your display area to better fit your digital flat-panel.

I Scaling Options

I Underscan U Overscan
10% 0%

I Use the scaling values instead of the customized

settings when the desktop resclution does not match
your DFP resclution.

Note: In some cases, the image on the screen will still appear a bit blur when you reach the
full screen display. This is due to a pixel ratio discrepancy with the TV. You then need to pull
the overscan slider to 0% then refer to the TV manual to adjust the display area.
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3.2 Play Movie Files

Video file types (format) File name extensions

Windows Media file .wm and .asf

Windows Media Video file wmyv

Windows video file .avi

Microsoft Recorded TV Show file .dvr-ms

Movie file .mpeg, .mpg, .mpe, .m1lv, .mp2 and .mpv2
etc.

Codec pack has been pre-installed on your system which allows your MC101 to playback various video formats
generally not supported by the operating system itself.

Note: You can extend the capabilities by installing additional codecs to play other file formats if needed.

Add the media (movie) file into the library:

Movies
ke
1A

movie library

There are no items in this library yet — Windows
Media Center is searching for media files in the

background. To add more movies, you can go
to Tasks > Settings > Media Libraries

You can add movies to your library by going
to Tasks > Settings > Media Libraries. Do you
want to add more movies now?

Add Movies




Using the MC101

Media Library Windows |

Select a Media Library

You can select folders for each media library, and the media files within
these folders will appear in Windows Media Center. Which library would
you like to set up?

Music

Pictures

Videos

Recorded TV
(®) Movies

Media Library

Movies
You can add or remove folders that Windows Media Center searches for

movie files. Your Movie library automatically includes DVDs and movies
you record from TV. What do you want to do?

(©) Add folders to the library

Media Library Windows Medi

Add Folders for Videos

Where are the folders you want to add?

(7) On this computer (includes mapped network drives)
On another computer
Let me manually add a shared folder

Media Library Windows M

Select folders that contain videos

Desktop
HTS72

Public

Local drive (C:)

New Volume (D:)

\HTS72 \Desktop

="Next | Cancel

14



Using the MC101

Media Library

Confirm Changes

Windows Media Center will search for media in the following locations:

[Music] C: \Users \HTS72 \Music
[Music] C: \Users \Public \Music
[Pictures]C: \Users \HTS72 \Pictures
[Pictures]C: \Users \Public \Pictures
[Videos]C: \Users \HTS72 \Videos

Are you finished making changes?
Yes, use these locations
No, | want to make more changes

< title >

A Knight's Tale [Blu-ray]

15



3. 3 Play Blu-ray Disc/ DVD in WMC

1. Install an external Blu-ray / DVD drive (Additional purchase of external optical drive required)

2. For Blu-ray playing, you will need to add additional software. This is usually provided with the drive. When installing, ensure
that you include the Plug-in for Windows Media Center. If no plug in is available, below procedure will not be valid and you will
have to use the third party software for Blu-ray playing.

3. Start Window Media Center from the “start” menu

(=) oMark11

MC101-demol

_.;,'/:f Paint v

Documents
o FurMark
ictur
Eﬂ Media Player Classic »

(=) 30Mark Vantsge

e AMD VISION Engine Control

Ig pr—

/] Netepad v

ices and Printers
CrystalDiskinfo
Default Programs

E WinRAR i tielp and Support

<
g Crysis2 - Shorteut

Getting Started »
& |

» Al Programs

4. Wait for Window Media Center start up screen

#9 Windows Media Center

5. On the main menu, select “Movies”

£ Windows Media Center

recorded tv




Movies

h!‘ >

play dvd

Note : Although the menu says Play DVD, it is also valid for Blurays if you have

installed the plug-in in step 2

6. Your Blu-ray / DVD is now loading

PowerDVD

7. The main menu of your Disk will now pop up, select the option and start enjoying your movie

Resume

Global rating from MoovieLive

L8 & & 84

Action/Adventure, Sci-Fi/Fantasy

Jonathan Mostow, Jonathan Mostow

Arnold Schwarzenegger, Nick Stahl, Claire Danes, Kristanna Loken, Arnold
Schwarzenegger, Nick Stahl

2009/05/12

The Machines Will Rise

17



3 .4 Play Music Files

3.4.1 WMC:

Music file types (format)

File name extensions

Audio CDs

.cda

Windows Media Audio file

.asx, .wm, .wma, and .

wmx

Windows audio file

.wav

MP3 audio file

.mp3 and .m3u

Codec pack has been pre-installed on your system which allows your MC101 to playback various audio formats

generally not supported by the operating system itself.

Note: You can extend the capabilities by installing additional codecs to play other file formats if needed.

Add the media (audio) file into the library:

Media Library

Select a Media Library

Windows Media Center (§

You can select folders for each media library, and the media files within
these folders will appear in Windows Media Center. Which library would
you like to set up?

(@LYTS
Pictures
Videos

Recorded TV

Movies

3.4.2 WMP:
Add the media (audio) file into the library:

@ Windows Media Player

Eile | View Play Teols

Help

Open...
Open URL...
Save As...

Close

Create Playlist
Create Auto Playlist

Save Mow Playing List

Add te Library...

Properties
Work Offline

Save Mow Playing List As...

Ch\Users\So5o\Desktop\VID_20110107_143548 3gp
Ch\Users\So5o\DesktopVID_20110107_143053 3gp

Ctrl+0

Burn
Ctrl+U
Ctrl+W
cn P
ent
F3

A

18



Add To Library

S5

Select the fo

@ My pers

ed automatically to reflect changes.

W Select folders that you want to monitor for media files. The Player librany on this computer is
updat

lders to monitor

onal folders

() My folders and those of others that | can access

C\Users\Public\Music

“\Users'\Public'Pictures

C
C:\Usersh
C

“\Users

Monitored Folders
CAUzersh 5o S0 \Music

\Public\\ideos

"SoSo'\Pictures

Type

Rip folder
Automatically added
Automatically added
Automatically added
Putomatically added ™

m

[ Add vol

Add files previously deleted from library

umedeveling values for all files (Elow)

Leam mare about monitoring folders

Skip files smaller than:
Audio files: 100 KB
Video files: 500 KB

[ << Advanced Options |

oK || Cancel |

Add To Library [ ]

S5

2 My fold

Select folders that you want to monitor for media files. The Player librany on this computer is
updated automatically to reflect changes.

Select the folders to monitor

@ My personal folders

ers and those of others that | can access

Chlsers
C\Users
C:\Users
C:\Users
C-\Users

Monitored Folders

50 S0 \Music
“Public\Music
“Public\Pictures
“Public\Videos
"SoSo'\Pictures

Type

Rip folder
Automatically added
Automatically added
Automatically added
Putomatically added ™

m

[ Add wol

Add files previously deleted from library

lumedeveling values for all files (Elow)

Leam mare about monitoring folders

Skip files smaller than:
Audio files: 100 KB
Video files: 500 KB

[ << Advanced Options |

0K

| [ Cancel

Add to Library by Searching Computer

B e

Search completed.

Progress
| 1
Current folder:
Files found: 93 Files added: 0
Close
—

19



3.5 Create Playlist

3.5.1 WMC:

Music

Wi mE
§, e
L

music library

< playlists >

< playlists >

Create Playlist

Create Playlist

Create a playlist of music, pictures, or both

albums

20



Using the MC101

Name Plavlist

Enter a name for the playlist. To enter text using the onscreen keyboard, press OK
on the remote control or double-click the text box

Enter a name for the playlist. To enter text using the onscreen keyboard, press OK
on the remote control or double-click the text box.

Favorite Songs

\lect Medi

Select a location to browse for media.

®) Music Library
Picture Library

No thanks, I'm finished

Favorite Songs
0 items, 0 minutes selected ["Next ]

Cancel

21



Using the MC101

Music

+
x

< albums >

Fine Music, Vol.
Richard Stoltzman

1 track

Favorite Songs
1 item, 2 minutes selected

& Edit Plav

Maid with the Flaxen Hair

Kalimba

Maid with the Flaxen Hair

Favorite Songs
2 items, 8 minutes selected

< playlists >

ACTIONS

Favorite Songs

Favorite Songs

22



m Using the MC101

3.5.2 WMP:

Select “Create Playlist”

@ Windows Media Player

rﬁ'\
@U » Library » Playlists »

Organize ~  Stream = |Create playlist B

Create playlist
D Library
4 | [] Playlists

|| Favorite Songs ’ |
4 JJ Music

@, Artist Favorite Songs
(=) Album
=y Genre

B Videos

= Pictures

= Recorded TV

[ Other media

& [ PEN_DISK

Create auto playlist

Lﬂ'-" Other Libraries

@ Windows Media Player

rﬁ‘\
@U v Library b Playlists +

Organize + Stream - Create playlist -

Title Count
B Library Playlists
4 |[i| Playlists
Clluniied piayis:R _DJ
|| Faverite Songs
4 I Music Favorite Songs
L, Artist
(= Album
&y Genre
& Videos
|=J| Pictures
(=) Recorded TV
[E) Other media
& [ PEN_DISK

Select “Create auto playlist”

MNew Auto Playlist

Select the criteria that you want to change in the auto playlist,

‘—"j) The auto playlist is updated automatically each time you open it.

Auto Playlist name: Untitled Auto Playlist]

Create an auto playlist that includes the following:
&' Music in my library
l‘-ﬂi[CIick here to add criteria]
And also include:
l‘-ﬂi[CIick here to add criteria]
And apply the following restrictions to the aute playlist:
Eﬂi[Click here to add criteria]

Remove QK LCancel

J |

Help

23



3.6 Add Radio Station

3.6.1 WMC:

A. To find and listen to an FM radio station:

3:s5eM @

Music
-
doi [

radio

1. On the start screen, scroll to Music, click radio.
2. To set Windows Media Center to find a radio station:
* Under Seek or Tune, click - or + to find available stations.
» If you know the frequency of the station, enter the numbers using the numeric keypad on the remote
control or on the keyboard.
3. To control playback, use the on-screen transport controls in the bottom right of the screen (this includes changing

channels, adjusting volume, and pausing or stopping playback).

1 2 @ @ ® ® @ ® @ 0O O @

1)Record S) Rewind 9) Fast Forward

2) Channel Decrease 6/ Skip Backward 10 Mute

3) Channel Increase 7) Pause and Play 11 Volume Decrease
4) Stop 8) Skip Forward 12 Volume Increase

You must configure the tuner for use with Windows Media Center before FM radio will display by doing the

following:

1. On the start screen, scroll to Tasks, click settings, click General, click Windows Media Center Setup, and then click
Set Up TV Signal.

2. Proceed through set up to configure your tuner. The radio option should appear after you have configured your tuner.

24



B. To find and listen to Internet radio

1. On the start screen, scroll to Extras, click Extras gallery, and then click music + radio.

3:0eM @

Extras
- %
-

extras gallery

< music + radio >

3.6.2 WMP:

A. Listen to internet radio

1. Look down on the left side and click on Media Guide

" FioKe moxe-pc)
Fine Music, Vol. 1 2 Maid with the Flaxen Hair ~ 2:49

Richard Stoltzman
Classical

f# Oscar (oscar)

£ 7 Media Guide q

£ Media Guide & O (= x@w Py » —@
Browse all online stores
B oo — |

2. Click “Internet Radio” at the top of the menu

25



3 Windows Media Player
G
Qrgenize = Steam

¥ Crystal (crystal)

¥ Floke (floke-pc)

% Windows Me:

Home | Music 1 | Movies |

Add internet radio station from URL

1. File>Open URL

[0 Windows Media Player

() » Library »

Music »_ All musi
File > Open.. cirl+0
9 view » Open URL.. Ctrleu
Play 5 Saye as... £ Title Length  Rsting o
Tools > Close CtrieW
a
> 3 Sleep Awa 320 ]
Help Create playlist Ctrl+N Pesy
Showmenubar  Ctr+M Create auto playlist
5] 100nitz - Today s Country Save Now Playing list
&) winr2 Save Now Playing list 2s...
5] WINR Smoothjazz P
s
- Manage libraries
A Artist
@ A E=p=Es 1 Kalimba 548 Mr
© Album Work offline
© Genre
& Videos Exit
[=] Pictures ninja tuna
= Recorded TV
&) Other media
. pEAES: Richard Stoltzman
Fine Music, Vol. 1 2 Maid with the Flaxen Hair 249 Ric
Richard Stoltz
[ Other Libraries O -
[ Crystal (crystal) zaaN | Classical

[ Floke (floke-pc)

2. Copy the internet radio URL and open. You can go onto www.listenlive.eu to get URLs of many radios

Open URL

>

(7 ]Sl

Enter the URL or path to a media file on the Internet, your
computer, or your network that you want to play.

Open:

hitt, E igh. -

0] 4 H Cancel ] ’ Browse...

The URL of the different radio stations can be found on the radio websites. The website Listenlive.eu (http://listenlive.eu)

also list a lot of URL for the different Europeans countries.

26


http://listenlive.eu/

3.7 Scan TV Signal

1) For first time user, go to ‘live tv setup’:

live tv setup

TV Setup Windows Mecia C

Region

Your region is used to configure your computer for local TV services.
Region: United States

Is this the correct region?

(7) Yes, use this region to configure TV services
No, | want to select a different region

TV Setup Windows Media Cente

Select Your Region

Select the appropriate region for your local TV services.

REN]
Heard Island and McDonald Islands
Honduras

Howland Island
Hungary

106 of 262 A Vv

1005 AM @

27



TV Setup Windows Med

Program Guide Terms of Service

To receive TV Program Guide listings, you must agree to the following
Terms of Service. Please note that by agreeing to this, information will be
sent to Microsoft. The information is not used to identify or contact you.

Windows Media Center for Windows 7

Electronic Programming Guide Terms Of Service

Version 5.0

Updated October 2008

The Microsoft software product identified above, which includes

(@)1 agree 1of 57 AV
I do not agree

Install PlayReady Windows Media Cer

Microsoft PlayReady™ PC Runtime EULA

PlayReady protects premium TV content from unauthorized use.

More Information

MICROSOFT SOFTWARE LICENSE TERMS
MICROSOFT PLAYREADY PC RUNTIME

These license terms are an agreement between Microsoft Corporation
(or based on where you live, one of its affiliates) and you. Please read
them. They apply to the software named above, which includes the
Seet? bt fond 16 3 Tho s lere R i

® | agree lof28 AV
| do not agree

Install PlayReady Windows |

Install PlayReady

Windows Media Center is downloading and installing PlayReady...

O

=—Cancel |

28



Using the MC101

TV Setup Windows I

TV Signal Configuration
The following TV signals will be configured for Windows Media Center:
Digital Antenna (DVB-T) (1 tuner)

Select Next to confirm.

- Next | Cancel

TV Setup Windows It

TV Channel Scan

Windows Media Center is scanning for TV channels you receive. This
process may take several minutes.

Stop Scan "

Scanning: 17% done

TV Setup Windows

TV Channel Scan
Windows Media Center has finished scanning for TV channels you receive.

Scanning: 100

No channels were found. Make sure your TV equipment is properly
connected to the computer.

29



For the next time, go to setting and change the configuration or scan TV channel:

Note: This procedure apply in the following cases:-

- You changed location of the MC101
- You change Antenna
- New channels become available in your area

There is no need to scan the channel each time you want to watch TV.

settings

General

Pictures

Music

DVD

Start Menu and Extras
Extender

Media Libraries

Recorder
Guide
fosga ]
Configure Your TV or Monitor
Language
Audio
Subtitle

1050 AM @
&
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TV SIGNAL

Scan for More Channels

Set Up TV Signal

Note: When TV Signal is set, go back to Main menu to start watching TV.

2. To watch TV, go to “TV guide” in the main menu

quide

Choose the program you want to watch in the guide, click on the title to start watching TV

BEN 10: ALIE
ata available
available
Good Morning Delhi
Chuggington
Filipino News

Sunrise

BEN 10: ALIEN FORCE -Rpt

par
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3. To search TV program, go to the main menu and go to TV “Search”

Choose type of search, for example, search by ‘Title’

(TR —

Keyword

Categories

Type in the title of the program
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Select and click on the program you are searching for

(SUnrise

Sunrise Extra

Sunrise Over South Africa

Weekend Sunrise

Sunrise

You can now select the showing program to start watching or you can record this program by pressing “record”

showinas

Sunrise

& record sernies

Sunrise
Sunrise

Sunrise

Wake up to a better breakfast with Melissa

Doyle and David Koch for all the latest new
600 AM - 900 AM

7 7 Digital

Note: You can watch all your record TV in main menu >TV >Record TV
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3. 8 Install Internet TV in WMC (only available for the U.S. region)

BTV
A A,

internet tv

Free streaming Int

Internet TV is an ¢

Install
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Free streaming Internet TV.

nternet TV is an online vi

4
'“! Downloading Internet TV

3 MB Remaining

Loading |,
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3.9 Migrate iTunes Library from another Computer

Note: users must first have iTunes installed on their system
1. In iTunes, select the “Advanced” Tab in “Edit>Preferences”
2. In the Advanced section, make sure "Keep iTunes Music folder organized" and "Copy files to iTunes Music folder

when adding to library" are checked.
[ @J iTunes I @‘

| General I Flayback I Sharing I Store I Parental Control I Devices | Advanced |

iTunes Media folder location
Csers\SoSoMusiciTunes\iTunes Music
Reset
Keep iTunes Media Folder Organised

Places files into album and artist folders, and names the files based on the
disc numiber, track number and song title.

Streaming Buffer Size:
Reset all dialogue wamings:
N Reset iTunes Store cache:

[7] Wam me if iTunes is not the defautt player for audio files
Keep Mini Player on top of all other windows

[T Keep film window on top of all other windows
[] Display visualiser full screen
[ Show iTunes icon in system tray

Minimise i Tunes »

i oKk | [ Cancel

3. Then, in the "iTunes Music folder location" area, click on the Change... button, and enter the new location where you
want to move your library to.

4. Re-locate the music folder to the new location from the other computer

5. Copy the folder [Album Artwork], [iTunes Music Library.xml] and [iTunes Library.itl] from the old computer from
“\Users\[your username]\My Music\”.

6. Paste them to your new location (anywhere).

7. Hold down the Shift key when you launch iTunes.

8. When it asks what library to use, click the "Choose Library..." button and browse to the iTunes Library.itl file on the

new location.

Choose iTunes Library
< iTunes needs 3 lidrary to Continue. You may <hoose an existing iTunes
)

Wbrary or create a new one.

{j‘]‘i—tﬁﬁ:; ( Create Library... ) ( Choose Library... )
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Upgrade and Recovery

4.1 Change Hard Disc Drive (HDD)

Step 1. Remove 7 screws

Step 2: Lift and remove back cover
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Upgrade and Recovery

Step 3: Remove hexagonal pole. ( note - for Barebone version, go directly to step 6)
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Upgrade and Recovery

Step 5: Remove HDD case to add HDD
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Upgrade and Recovery

Step 8: Slide HDD case toward the back and plug it into the connection slot

Step 9: Screw the hexagonal pole back into the case
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Upgrade and Recovery

Step 10: Replace the back cover

Step 11: Assemble and fix the 7 screws back in place
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4.2 Recovery Using the Recovery in Control Panel

1. Press the Start Button and in the search input area, type "Recovery".

GO-\ 1 » Computer b Recovery (E) b Recovery ~[4 ][ 5=

Qrganize v Include in library ¥ Share with ¥ New folder Ev 0 @
Name Date modified Type Size

¢ Faverites
I Desktop
18 Downloads

This folder is empty.

Control Panel (9)

[ Recovery
¥ Review your Rering
P Restore your { Restore your system to an earlier time withaut affecting your files, or
Pv Fix problems replace everything on your computer and reinstall Windows.

18 Create 2 restore point

1™ Restore system files and settings from a restore point
i Restore your computer or reinstall Windows

b Back up your computer

b Restore data, files, or computer from backup

52 Seemore results

[[recoven] x| [ shutdewn || Wind

/. Build 7057 winmain.090:
= orospm. | |
5 Es v 05 p.m.
B oo

2. From the search results, launch the Recovery control applet.

3. Select the "Advanced recovery methods" option.

2

-
3.

S

e

OO»,’!‘; » Control Panel » All Control Panel ltems » Recovery BEAE

Centrol Panel He 2 i P
sbdi i Restore this computer to an earlier point in time

Troubleshoot a problem System Restore can resolve many system problems, and is the best recovery method to try first. For
ininstall & program serious problems, use the advanced recovery methods,

Restore your iles
System Restore

Undo recent system changes, but leave files such as documents, ) Open System Restore

pictures, and music unchanged. This might remove
recently-installed programs and drivers.

See also

Action Center

Windows 7
Evaluation copy. Build 7057.winmain.090305-2000
0106 p.m. |
01/04/2009

B o g,
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(o1 -T2 - Upgrade and Recovery

4. Select "Reinstall Windows" option.

2

=

[ETCSET

G@v D « Recovery » Advanced Recovery Methods

Choose an advanced recovery method

After you have chosen a method, you'll have the opportunity to back up yourfiles, such as documents,
pictures, and music. Help me choose 2 recovery methed

& Use a system image you created earlier to recover your computer
I you have created 2 system image, you can use it to replace everything on this computer, including
Windows, your programs, and all your files, with the information saved on the system image.

@ Reinstall Windows
This option will reintall Windows on your computer. Aftenward, you can restore your il from 2
backup. Any programs you've installed will need to be reinstalled using the original installation discs or
files. Exsting fles might remain i the Windows.old folder on your hard disk after the reinstall
compltes N

Windows 7
Evaluation copy. Build 7057.winmain.090305-2000

. o g, OM06pm.
2 om0

G@o\.ﬁ- Recovery » Advanced Recovery Methods » User File Backup ~ [ ][ searen c:

Do you want to back up your files?

Before continuing, you can back up files such as documents, pictures, and music to an external hard disk,
DVD, CD, or USB flash drive.

After the recovery process is completed, Windows will help you restore these files to your computer. If you
skip this step, you might lose your files,

/i Windows could not find any file backups on this computer. Click "Back up now” to create 2 file backup.

Windows 7
tion copy. Build 7057.winmain 090305-2000
01:09 p.m.

o
= 01002009

G‘@-\“?« ‘Advanced Recovery Methods » User File Backup » Restart

Restart your computer and continue the recovery

If you are restoring your computer from 2 system backup, you will be able to select your backup date, if more
than one exists.

fou to Py
pictures, and music if you continue.



(o T-1214-1. -8 Upgrade and Recovery

6. Verify that the computer starts in Windows RE.

windows is loading files...

7. From the System Recovery Options dialog box, select a language and keyboard layout.

# System Recovery Options 1

Select a keyboard input method:
2

8. Click the Yes button to reinstall Windows using the image you placed in the recovery partition

Reinstall Windows
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(o1 -T2 - Upgrade and Recovery

Note: By selecting Yes, Windows will begin the reinstallation of Windows using the recovery image
you created.

£7 Install Windows

Installing Windows...

That's all the information we need right now. Your computer will restart several times during
installation.

Copying Windows files (0%) .
Expanding Windows files
Installing features

Installing updates
Completing installation

1 Collecting information 2 Installing Windows

9. Once the Windows Setup is complete, the PC will reboot. Complete Windows Welcome.
Note: If you create a backup prior to the restore, you'll have the option to restore the backup.

Recovery

D Recovery has completed. Do you want to
= restore your user files?

f you created a user file backup before recoverin
your computer, you can restore those

(Brcmoremyie]
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4.3 Recovery Using the Advanced Boot Options

To access the Advanced Boot Options perform the following tasks:

1. Turn on the computer.

2. Press F8 before Windows starts.

Advanced Boot Options

Choose Advanced oOptions for: Windows 7
(Use the arrow keys to highlight your choice.)

Repair Your Computer

safe Mode
Safe Mode with Networking
Safe Mode with Command Prompt

Enable Boot Logging

Enable Tow-resolution video (640x480)

Last Known Good Configuration (advanced)
Directory Services Restore Mode

Debugging Mode

Disable automatic restart on system failure
Disable Driver Signature Enforcement

start windows Normally

Description: view a list of system recovery tools you can use to repair
startup problems, run diagnostics, or restore your system.

ENTER=Choose ESC=Cancel

Note: If Windows starts, you did not press F8 within the appropriate time allows. Shutdown the
computer and try again.

3. From the System Recovery Options dialog box, select a language and keyboard layout.

E ——

# System Recovery Options
Sl

Select a keyboard input method:
e
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Upgrade and Recovery

4. Select the user you created.

System Recovery Options:

To access recovery options, log on as a local user.

To access the command prompt as well, log on using an administrator
account.

Password:

5. Select Reinstall Windows.

# System Recovery Options

Choose a recovery tool
Operating system: Windows 7 on (F:) 05
' 8
a@ Automatically fix problems that are preventing Windows from starting
| System Restore
Restore Windows to an earlier pointin time

System Image Recovery
Recover your computer using a system image you created earlier

Windows Memory Diagnostic
Check your computer for memory hardware errors

Command Prompt
Open a command prompt window

Reinstall Windows
Reinstall Windows using installation files stored on the hard disk

Shut Down Re